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W elcome to the 50th Edition of The Leadership 
Ledger. It includes Post, Department and  

National reports, leadership training events, upcoming 
conferences/conventions as well as rules and regulations 
pertaining to local, state and national laws. The Ledger 
is available by visiting the Department’s website at 
www.mainelegion.org under “News & Events” or on 
the home page. If you have any information to be pub-
lished in The Leadership Ledger, please forward to De-
partment HQ via email at:legionme@mainelegion.org. 

 

DISTRICT MEETINGS 
Be Connected – Be Heard – Be Informed 

District 6 – Knox: Sept 25 
St. George Post 34, 9AM 

District 8 – Sagadahoc: Oct. 2 
Bath Post 21, 1:00PM 

District 17 – No. Aroostook: Oct. 3 
Fort Kent Post 133, 1PM 

District 2 – Cumberland: Oct. 10 
So. Portland Post 35, 2PM 

District 15 – Washington: Oct. 10  
Lubec Post 65, 2PM 

District 12 – Hancock:  Oct. 12 
Location TBD 

Dinner at 6:30PM, Meeting at 7:30PM 
District 9 – Kennebec: Oct. 13 

Winthrop Post 40, 7PM  
District 5 – Oxford: Oct. 19 

Buckfield Post 58, 7PM, Pumpkin Pie after. 
District 6 – Knox: Oct. 23 

Camden Post 30, 9AM 
District 14 – Piscataquis: Oct. 23 

Milo Post 41, 12 Noon Lunch w/Business Meeting 
at 1PM * Luncheon still served??? 

Note:  If you haven’t submitted your district 
meetings for 21-22, please do so as soon as possible! 

 

2021 AMERICAL LEGION 

FALL CONFERENCE MEETING 

AGENDA 
 

Stephen W. Manchester Post 62  
17 Dunn St. Westbrook 

September 25, 2021 @ 9:00 a.m. 
 

Opening Ceremony:  

1. Post Colors  
2. Prayer 
3. POW – MIA 
4. Pledge of Allegiance  
5. Preamble 
6. Introduction of Guests 
7. Opening Remarks from Commander Couture 

Introduction: 

1. Facilitators – 1st Vice Commander Kirk 
Thurston/Adjutant Paul L’Heureux 

2. Introduction of Staff Liaison (N.E.  
Region), I.A. & Membership Division, 
Kevin Mook 

Program Subject: 

1. Member Engagements 
2. MyLegion.org Overview 
3. Building a Membership Team 
4. Engaging Other Veteran Organizations 
5. Question/Answer Session 

Other Brief Subject Matters: 

1. Oratorical – Dale Midgley 
2. Dirigo State – Matt LeClair 
3. History Book by Robert Fuller, West-

brook Post 62 

Closing Remarks 

http://www.mainelegion.org
mailto:legionme@mainelegion.org
http://www.mainelegion.org
mailto:legionme@mainelegion.org
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FALL CONFERENCE 2021  

~  SCHEDULE OF EVENTS ~ 

 

Friday, September 24th  

Entertainment and socializing: Westbrook Post 
197, 300 Conant St., Westbrook 

Saturday, September 25th  

Breakfast: Post 62 and Post 197 - donuts/pastries/
coffee, tea, orange juice, water, fresh fruit - FREE 

Legion Fall Conference: Westbrook Post 62, 17 
Dunn St., Westbrook  9 – 4 p.m. 

Auxiliary Fall Conference : Westbrook Post 197, 
300 Conant St., Westbrook  9 – 3 p.m. 

SAL Fall Conference: Westbrook Post 197, 300  
Conant St., Westbrook  9 – 11 p.m. 

 

 SOCIAL  

3:30 – 5:30 p.m. Westbrook Post 62 
17 Dunn St., Westbrook 

Live Music 

Appetizers including deviled eggs,  
fruit appetizer,  

chicken parm meatballs 
 

 

BBQ DINNER: 6:00 p.m. Westbrook Post 197, 300 
Conant St., Westbrook (See below for details.) 

Entertainment: 7 – 11 p.m. Westbrook Post 197, 
300 Conant St., Westbrook 

Sunday, September 26th  

Breakfast Post 197:  Waffle bar, hazelnut spread, 
strawberries, apple topping, blueberries, fudge 
sauce, whipped cream and sausages - FREE 

Legion and Auxiliary Department Executive  
Committee meetings – Westbrook Post 197, 9 a.m. 

Note: Legion Department Officers Meeting at 
8:00 a.m. 
 
 

~~~~~~~~~~~~~~~~~ 

 

~  HOTEL LIST ~ 

Please contact the hotels directly or reserve online. 
Group rates are not available. 

Exit 48 off the Maine Turnpike: 

• Super 8 by Wyndham, 208 Larrabee Rd.,  
Westbrook, Maine (207) 209-2480 (No 
elevator) 

• Fireside Inn & Suites, 81 Riverside St., 
Portland (207) 774-5601 

• Motel 6, 1 Riverside St., Portland (207) 
775-0111 

There are many more hotels in the Portland area if 
you go online.  

~~~~~~~~~~~~~~~~~ 

 

LUNCH AND DINNER MEAL CHOICES 
FOR SATURDAY, SEPTEMBER 25th 

(Lunch Available at both Post 62 & Post 197) 

_____ Lunch - $8.00 per person, pre-paid only  
 _____ GLUTEN FREE 

Club sandwiches, assorted wraps, pasta salad, home-
made potato chips, cookies/brownies & soda/water     

(Dinner will be at Westbrook Post 197) 

_____ Dinner - $15.00 per person, pre-paid only  
 _____ GLUTEN FREE 

BBQ - hamburger sliders, barbecue chicken, pulled 
pork sliders, potato salad, Cole slaw,  mac-n-cheese, 
cornbread, beans, apple crisp dessert & chocolate 
whoopie pies and pumpkin whoopie pies, soda/water. 

_____ Combo – lunch and dinner, $20.00 per  
person, pre-paid only 

~~~~~~~~~~~~~~~~~ 

Make checks payable to: 

ALA Unit 197 

Mail to:  
 

Stasi Heitman 
American Legion Post 197 

300 Conant St., Westbrook, ME 04092 

Call Post 197 for last minute reservations: 

854-5788  
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NATIONAL COMMANDERS 
CAMPAIGN 

T o Our Fellow Legionnaires: 

As you may be aware, each year we request 
donations to be given to the leading candidate for the 
position of National Commander of The American  
Legion. The individuals do a lot of traveling and have 
expenses which they may need assistance in covering. 

     We are asking you to consider donating to this 
great cause so that the Department of Maine can  
support the leading candidate, Vincent James  
Troiola in their quest for election to the high  
position of National Commander.  

     Each department donates to this cause and we are 
not the only one to do so. The many departments also 
supported our own Tony Jordan when he was cam-
paigning for National Commander and it is only right 
that we, the Department of Maine, do so also. 

     Your donations will be greatly appreciated.  
Please send them to the Department of Maine 
Headquarters at 5 Verti Drive, Winslow, ME 04901 and 
earmark in the “Memo” position of your check or 
money order “National Commander Donation.”   

     The donations will be given to the lead candidate, 
Mr. Troiola, at the soonest possible time. 

     Thank you and let’s make this one a great one! 

                                    
    Lloyd Woods      Anthony G. “Tony” Jordan  
  National Executive               Past National Command

 

NEW MYLEGION.ORG 
INSTRUCTIONS/
INFORMATION  
FOR MEMBERSHIP 
PROCESSING,  
GROUP PERMISSIONS & MORE! 

Now that the myLegion site is live, all accounts are 
now MEMBER accounts.  This includes Legion and 
SAL members.  The first requirement to access post 
and squadron data is to create a myLegion member 
account using the email address on your membership 
record. The new myLegion Home page will look like the 
image above. It provides links to your subscriptions,  
discounts, and  resources.  MY ACCOUNT provides 
more information about your own membership. To 
learn more, please click on the image or title above for 
information and instructions or the Video 
Presentation / PowerPoint links below.  

Video Presentation  /  PowerPoint  /  Q&A 

WWII POW/MIA VETERAN  
U.S. ARMY AIR FORCE 2ND  
LT. ERNEST N. VIENNEAU  

On Saturday October 9th at 10:30am, in Millinocket 
the Nation and Maine will lay to rest a  WWII POW/
MIA Veteran U.S. Army Air Force 2nd Lt. Ernest N. 
Vienneau that has been lost to all since 1944.   

Lt. Vienneau was a co-pilot attached to the 340th 
Bombardment Squadron, 97 Bombardment Group, 
15th Air Force, stationed in Amendola, Italy.  The B-
17 Flying Fortress Bomber was on a mission over 
Maribor, Yugoslavia when it was it by fire.  Lt. 
Vienneau was killed instantly by shrapnel.  The pilot 
was forced to down the plane off the coast of Vis 
Island, Croatia. All ten of the members of the crew 
survived this day. Lt. Vienneau’s body was never 
recovered. 

April 16, 2021, Lt Vienneau’s remains were recov-
ered. He will be buried with Full Military Honors 
with a flyover on October 9th.  The American Legion 
Riders will escort Lt. Ernest Vienneau to his final 
resting place in Millinocket.  American Legion Rid-
ers are asked to meet at American Legion Post 80 in 
Millinocket and then will go to the funeral home to-
gether for 9:45am.  The funeral will be at St. Mar-
tin’s Catholic Church at 10:30am. 

American Legion Post 80 will hold a luncheon at the 
post following the burial. 

“This will be an honor that we may never see again 
in our lifetime, to welcome home a POW/MIA” said 
Rick Cyr Jr. ALR Chapter 80 Director.  

 If you would like to read more about the story of Lt. 
Vienneau follow the link below. 

Lt. Vienneau and his family sacrifice will be remem-
bered by all. 

https://wgme.com/news/local/remains-of-maine-
pilot-killed-during-world-war-ii-recovered-off-
coast-of-croatia 

 

 

 

 

 

 

 

 

 

                                               2nd Lt. Ernest N. Vienneau  
 

http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
http://www.mainelegion.org/media/Membership/PPT_MyLegion_Update_Membership_Processing_with_notes.pdf
https://vimeo.com/518232870
https://www.legion.org/documents/training/training-tuesdays/PPT_MyLegion_Update_Membership_Processing.pptx
https://www.legion.org/training/251904/training-tuesday-mylegion-update-membership-processing-qa
https://wgme.com/news/local/remains-of-maine-pilot-killed-during-world-war-ii-recovered-off-coast-of-croatia
https://wgme.com/news/local/remains-of-maine-pilot-killed-during-world-war-ii-recovered-off-coast-of-croatia
https://wgme.com/news/local/remains-of-maine-pilot-killed-during-world-war-ii-recovered-off-coast-of-croatia
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POST SERVICE  
OFFICER TRAINING   

P ost Service Officer Training scheduled for Sept. 
29 from 10:00 am – 2:00 p.m. has been cancelled. 

For more information e-mail Carl Curtis at 
carl.curtis2@va.gov. 

 

 

MAINE LEGION 
COLLEGE CLASS  
FOR 2021 

M aine Legion College Classes for the 2021 year have 
been cancelled. For more information contact 

American Legion State Headquarters at 207.873-3229. 
 

 
HONOR FLIGHT 
MAINE FLIGHT  
TRIPS - September & October 

 

 

For more information CLICK HERE or visit: 
https://www.legion.org/benefits    

 

MEMBERSHIP IMPACT REPORTS 

T he American Legion’s success depends entirely 
on active membership, participation and volun-

teerism. The following monthly reports located on 
https://www.legion.org/membership/impact pro-
vide a summary of membership, participation and 
volunteerism making an impact in the lives of veter-
ans, families and communities. American Legion 
Posts can share the many ways Legionnaires are 
making a difference in their communities by sub-
mitting consolidated post reports online. To visit 
the impact American Legion posts made throughout 
the year, visit:  

https://www.legion.org/bythenumbers   or 

https://www.legion.org/membership/impact.  

 

The Maine Legionnaire 

~ Printing Delay! ~ 

The August issue of The Maine Legionnaire 
has been delayed and will be printed in  

November due to various reasons including, but not 
limited to; mylegion.org, staffing issues and an 

overabundance of photos and articles. 

EXEMPT ORGANIZATIONS   
E-FILE - E-POSTCARD 

organizations? 

B eginning in 2008, small tax-exempt organizations 
that previously were not required to file 

returns may be required to submit an annual  
electronic notice, Form 990-N, Electronic Notice 
(e-Postcard) for Tax-Exempt Organizations not  
Required To File Form 990 or 990-EZ. This filing 
requirement applies to tax periods beginning after 
December 31, 2006. Organizations that fail to meet 
their annual filing requirement for three consecutive 
years are subject to losing their tax-exempt status. 

Small tax-exempt organizations, whose gross 
receipts are normally $50,000 or less, are not  
required to file Form 990, Return of Organization 
Exempt From Income Tax, or Form 990-EZ, Short 
Form Return of Organization Exempt From Income 
Tax. These small tax-exempt organizations are  
required to file electronically the e-Postcard, Form 
990-N, with the IRS annually. Exceptions to this 
requirement include organizations that are included 
in a group return, private foundations required to 
file Form 990-PF, and section 509(a)(3) supporting 
organizations required to file Form 990 or Form 
990-EZ. In addition, this filing requirement does not 
apply to churches, their integrated auxiliaries, and 
conventions or associations of  

See e-Postcard (Form 990-N) 
for more information about this requirement. 

Page Last Reviewed or Updated: 04-Mar-2021

 
 

“It is a proud privilege to be a soldier –  
a good soldier [with] discipline,  

self-respect, pride in his unit and his 
country, a high sense of duty and  
obligation to comrades and to his  
superiors, and a self-confidence  
born of demonstrated ability.” 

 
“It is foolish and wrong to mourn the 

men who died. Rather, we should thank 
God that such men lived.”  

 
~ George S. Patton Jr.  

 
 

mailto:carl.curtis2@va.gov
https://www.legion.org/benefits
https://www.legion.org/benefits
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
http://www.mylegion.org/
http://www.mylegion.org/
https://www.legion.org/bythenumbers
https://www.legion.org/membership/impact
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The American Legion, Department of Maine 
High School Oratorical Scholarship Program 

Thomas College 
180 West River Rd. 

Waterville, Maine 04901 

February 12, 2022 at 9:00 a.m.   

(Snow date: February 19, 2022) 

T he American Legion, Department of Maine High 
School Oratorical Scholarship Contest will once 

again be held at Thomas College in Waterville on 
February 12, 2022 at 9:00 a.m. Snow Date:  
February 19, 2022 at 9:00 a.m. 

The main purpose of The American Legion Oratorical 
Contest “A Constitutional Speech Contest” is to  
develop a deeper knowledge and appreciation for the 
U.S. Constitution among high school students. Other 
objectives of the contest include the development of 
leadership qualities, the ability to think and speak 
clearly and intelligently, and the preparation for  
acceptance of the duties, responsibilities, the rights  
and privileges of American citizenship. 

Young orators will have the opportunity to earn 
some of the most generous scholarships. At the Post 
and District level, scholarships offered range from 
$50 - $100, and at the State level $50 - $1500. At the 
National level, each department (state) winner who 
is certified and participates in the National Oratorical 
Contest’s 1st round receives $2,000 scholarship. 
Each first round winner who advances to and  
participates in the second round, but does not  
advance to the final round, will receive an additional 
$2,000 scholarship to pursue education beyond high 
school. The overall national contest winner gets an 
$25,000 scholarship. Second place takes home 
$22,500, and third gets $20,000.  The members of 
the Oratorical Committee will be working with both 
Area and District Commanders to prepare Posts and 
Districts for their local contests. We hope to have all 
Post contests completed by Mid-December 2021 and all 
District contests completed by the end of January 2022.  

The 2022 National Finals is April 22-24 in  
Indianapolis, at the Wyndham Indianapolis West.  
Quarterfinal and semifinal contests are scheduled for 
Saturday, April 23, with the finals scheduled for 
Sunday, April 24. Certification of Department 
winners is due to National by March 14, 2022. 

For additional questions and/or information  
pertaining to the Oratorical Contest in Maine, please  
contact Oratorical Co-Chairman Dale Midgley at  
207-590-3532 | e-mail: midgleyd@earthlink.net or 
Oratorical Co-Chairman Maureen Malley at 

maureenmalley.66@gmail.com. More information 
can be obtained by visiting www.mainelegion.org, 
your local American Legion Post, or The American 
Legion, Department of Maine Headquarters at  
207-873-3229. Please check out the State and Local 
Oratorical Contests by visiting National’s website at 
www.legion.org/oratorical. 

 

LETTER FROM THE ORATORICAL  
CO-CHAIRMAN DALE MIDGLEY 

I f you have never attended the High School Oratorical 
Finals, you are missing the opportunity to see 

some of the very Brightest and Talented High 
School Students in the State of Maine! 

Did you know that: The Original proposed Bill of 
Rights contained 12 Rights not 10? 

Did you know that:  James Madison, author of the 
Bill of Rights, used the Magna Carta (1215), 

English Bill of Rights (1689) and the Virginia  
Declaration of Rights (1776) in writing the proposed  
amendments to the Constitution. 

Did you know that:  The Constitution was finally 
ratified by all 14 States in January 1791, the last 
being Vermont. 

Did you know that:  A proposed Bill of Rights 
Amendment submitted in 1789 was not officially 
ratified until 1992 and became the 26th Amendment? 

I didn’t know any of these things, plus a whole lot more, 
until I attended our Post Oratorical Contest, the District 
Oratorical Contest and the State Oratorical Contest. 

The students who research and present their  
Prepared Speech and Assigned Topics will amaze 
you by how much time and effort they have spent 
rehearsing and polishing their presentations. 

I hope to see you at the Oratorical Finals, for I am 
sure, I will learn even more about the U.S. Constitu-
tion and the Bill of Rights again this year at the Post, 
District and State Finals. 

For More Information  Click Here  

or go to 
www.mainelegion.org/pages/programs/oratorical.php 

For the Oratorical Committee, 
Dale Midgley 

Department of Maine HS Oratorical  
Scholarship Application 

Department of Maine 
Oratorical Brochure 

2022 Oratorical Rules Brochure   

Oratorical Promotional 
Brochure - National 

http://www.mainelegion.org/pages/programs/oratorical.php
http://www.mainelegion.org/pages/programs/oratorical.php
mailto:midgleyd@earthlink.net
https://en.wikipedia.org/wiki/Preamble_to_the_United_States_Constitution
mailto:maureenmalley.66@gmail.com
http://www.mainelegion.org
http://www.legion.org/oratorical
http://www.mainelegion.org/pages/programs/oratorical.php
http://www.mainelegion.org/pages/programs/oratorical.php
http://www.mainelegion.org/media/Oratorical/2022-Oratorical_Application_FILLABLE.pdf
http://www.mainelegion.org/media/Oratorical/2022-Oratorical_Application_FILLABLE.pdf
http://www.mainelegion.org/media/Oratorical/2022-Oratorical_Brochure_Maine_2.pdf
http://www.mainelegion.org/media/Oratorical/2022-Oratorical_Brochure_Maine_2.pdf
https://www.legion.org/sites/legion.org/files/legion/publications/07ACY0521%20Oratorical%20Official%20Rules.pdf
http://www.mainelegion.org/media/Oratorical/2020%20Oratorical-%20Offical%20Rules%20Brochure.pdf
https://www.legion.org/sites/legion.org/files/legion/publications/62ACY0420%20Oratorical%20Promo%20Brochure.pdf
https://www.legion.org/sites/legion.org/files/legion/publications/62ACY0420%20Oratorical%20Promo%20Brochure.pdf
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MILITARY  
TRIVIA:  

Q: What single 

country has more US 
Military bases than 
are found in any  
single US state & 
what is it’s name?  

 

VETERAN’S EMERGENCY 
FINANCIAL ASSISTANCE 

PROGRAM (VEFAP) 

D o you know of a veteran in your community in 
need of assistance? Someone who during these 

challenging times just needs a little help to keep 
them going? Maybe a veteran that is homeless? Or 
worst of all, a homeless veteran with children? If so, 
we want to remind you that The American Legion, 
Department of Maine can assist you to help these 
veterans during their difficult and troubling times. 

     You can call us at 207-873-3229 Ext. 3 or visit our 
website: 

http://www.mainelegion.org/pages/ 
resources/va-resources.php 

     We will contact you as soon as possible and 
we hope to enable you to help veterans in 
need. 

 
For more information CLICK HERE or go to: 

www.legion.org/benefits  

 

 

 

 

 

 

 

SPECIAL DISCOUNTS & 
PERKS FOR VETERANS 

Free National Park Passes   
VA pension benefits | 10% off at Outback 

Veterans get free entrance to national parks, ref-
uges and other public lands 

 

V eterans, Gold Star Families, current Military 
and their dependents have free access to ap-

proximately 2,000 public locations spread out across 
more than 400 million acres of public lands, which 
host activities to fit any lifestyle, from serene to high  
octane, including hiking, fishing, paddling, biking, 
hunting, stargazing, camping and much more. 

For more perks  Click Here  or go to:  

Veteran discounts available year round - VAntage Point  

~~~~~~ 

Enhanced pension benefits help eligible wartime 
Veterans, surviving spouses increase income 

If you are a wartime Veteran who meets certain  
requirements, or you are a surviving spouse, then 
you may be eligible for VA’s pension benefits. VA’s 
Aid and Attendance and Housebound benefits, or  
enhanced pension, can boost your pension payments. 
If you need help with daily activities, or if you are 
housebound, you may qualify for an increased 
monthly pension. 

 

IMPORTANT DATES  
IN MILITARY HITORY 

 

October 

➢ 10/7 Afghanistan War Began (2001) 
➢ 10/13 US Navy Established (1775) 

➢ 10/20 Women’s  Army Corps Disestablished 
(1978) 

➢ 10/23 Grenada Campaign Began (1983) 
➢ 10/24 United Nations Day 
➢ 10/27 Navy Day 
 

DONATIONS 
AMERICAN LEGION 

DEPARTMENT OF MAINE 

Veteran’s Fund 

Timothy Roy, Augusta, ME    $ 30.00  
 

Irving Oil 
Savings 

? 

http://www.mainelegion.org/pages/resources/va-resources.php
http://www.mainelegion.org/pages/resources/va-resources.php
http://www.mainelegion.org/pages/resources/va-resources.php
https://www.legion.org/benefits
https://www.legion.org/benefits
https://blogs.va.gov/VAntage/80547/veterans-gold-star-families-get-free-entrance-national-parks-refuges-public-lands/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://blogs.va.gov/VAntage/94273/enhanced-pension-benefits-help-eligible-wartime-veterans-increase-income/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://blogs.va.gov/VAntage/85765/veteran-discounts-available-year-round/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources
https://blogs.va.gov/VAntage/80547/veterans-gold-star-families-get-free-entrance-national-parks-refuges-public-lands/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://blogs.va.gov/VAntage/80547/veterans-gold-star-families-get-free-entrance-national-parks-refuges-public-lands/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://blogs.va.gov/VAntage/85765/veteran-discounts-available-year-round/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources
https://blogs.va.gov/VAntage/85765/veteran-discounts-available-year-round/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources
https://blogs.va.gov/VAntage/94273/enhanced-pension-benefits-help-eligible-wartime-veterans-increase-income/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://blogs.va.gov/VAntage/94273/enhanced-pension-benefits-help-eligible-wartime-veterans-increase-income/?utm_source=VRfeature&utm_medium=email&utm_campaign=VetResources&utm_id=VetResources+Sep+15+2021
https://lnks.gd/l/eyJhbGciOiJIUzI1NiJ9.eyJidWxsZXRpbl9saW5rX2lkIjoxMzAsInVyaSI6ImJwMjpjbGljayIsImJ1bGxldGluX2lkIjoiMjAyMTA5MTYuNDU5OTczMzEiLCJ1cmwiOiJodHRwczovL2JlbmVmaXRzLnZhLmdvdi9CRU5FRklUUy9mYWN0c2hlZXRzL2xpbWl0ZWRpbmNvbWUvRW5oYW5jZWRvclNwZWNpYWxQZW5zaW9u
https://lnks.gd/l/eyJhbGciOiJIUzI1NiJ9.eyJidWxsZXRpbl9saW5rX2lkIjoxMzAsInVyaSI6ImJwMjpjbGljayIsImJ1bGxldGluX2lkIjoiMjAyMTA5MTYuNDU5OTczMzEiLCJ1cmwiOiJodHRwczovL2JlbmVmaXRzLnZhLmdvdi9CRU5FRklUUy9mYWN0c2hlZXRzL2xpbWl0ZWRpbmNvbWUvRW5oYW5jZWRvclNwZWNpYWxQZW5zaW9u
https://www.history.com/this-day-in-history/u-s-led-attack-on-afghanistan-begins#:~:text=On%20October%207%2C%202001%2C%20a%20U.S.-led%20coalition%20begins,were%20provided%20by%20the%20anti-Taliban%20Northern%20Alliance%20rebels.
https://www.history.navy.mil/browse-by-topic/commemorations-toolkits/navy-birthday/OriginsNavy/the-establishment-of-the-department-of-the-navy.html#:~:text=The%20United%20States%20Navy%20traces%20its%20origins%20to,off%2C%20and%20the%20seamen%20and%20offic
https://www.army.mil/women/history/
https://www.army.mil/women/history/
https://en.wikipedia.org/wiki/United_States_invasion_of_Grenada
https://www.un.org/en/observances/un-day
https://www.history.navy.mil/content/history/museums/nnam/education/articles/history-up-close/navy-day.html
http://smile.amazon.com/
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingenergy.com/
https://www.irvingenergy.com/
https://www.irvingenergy.com/
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Computer 101 is a resource which aims to help 
those who wish to learn basic skills with the powerful 
technology of today’s world. Increased proficiency 
with computers and the Internet has positive outcome 
across all fronts, both personally and professionally.  

How to Make a Brochure in  
Microsoft Word 

Templates Save Time and Effort for Almost Any 
Word Project 

1. Select File > New. 

2. In the Search for Online Templates text box, 
type brochure, then press Enter. 

3. Choose the style you want and select Create to 
download the template. The template automati-
cally opens in a new Word document. 

4. Select sample text in any section and enter 
your custom text. Replace the sample text 
throughout the template. 

5. To customize the text, change the font, color, 
and size. 

6. Replace the sample images, if desired. Select 
an image, right-click, and select Change 
|Image. Choose the location of the picture you 
want to use, navigate to the image, then se-
lect Insert. 

7. To change the default color theme of the  
template, go to the Design tab. 

8. Select the Colors drop-down arrow and choose 
a theme. 

9. Point to a theme in the Colors drop-down list 
to 
preview before applying it. 

10. Save the changes to the brochure when you are  
finished customizing it. Refer to the printer  
documentation or manufacturer website to find  
instructions on how to print double-sided docu-
ments. 

For more tips CLICK HERE or go to: 

https://www.lifewire.com/ 

SCAM ALERT!   

I f you receive this notice from “US Domain 
Authority”, toss it in the trash! 

This notice can easily be mistaken as a bill to renew 
your domain registration. In reality, as “US Domain 
Authority” makes clear on a second page, they’re 
not domain registrars at all. Instead, they’re a 
directory service, sort of like 20th Century phone 
books were directories for phone numbers. All you 
get for your $289.00 is your domain name added to 
their directory. The disclaimer indicates on the back 
page,  that “This is not a bill. This is a solicitation. 
You are under no obligation to pay the amount  
stated above unless you accept this offer.” 

 

 

Click HERE for More Information or go to: 

No Cost LegionCare - lit (thelit.com)  

SCAM ALERT 
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MEMBERSHIP: FREQUENTLY 
ASKED QUESTIONS 

Eligibility Questions 

Are you eligible? Here are a few frequently asked 
questions regarding American Legion eligibility. For 
any other eligibility questions, feel free to contact us 
at membership@legion.org or 317-630-1321. 

What are the eligibility dates for membership in 
The American Legion? 

Thanks to the LEGION Act (Let Everyone Get  
Involved In Opportunities for National Service Act), 
Congress expanded the current eligibility period to 
cover Dec. 7, 1941, to the present, and includes the 
current war campaigns. Previously, there were seven 
declared war periods. Now there are two, the current 
war period dating back to World War II and another 
war era covering World War I. No other restrictions 
to American Legion membership changed. 

I’m currently on active duty. Am I eligible? 

Yes, you are a veteran. All current active duty  
military are eligible for membership. 

I didn’t retire from the military, but was on  
active duty during one of the qualifying time  
periods. Am I eligible? 

Yes, you are a veteran. As long as you have served 
at least one day of federal active duty during any 
qualifying period, you are eligible for membership. 

I served during one of the qualifying periods, but 
was never in a combat zone. Am I eligible? 

Yes, you are a veteran. Location of active duty  
service is not a consideration for membership. 

I’m currently in the National Guard/Reserve. My 
unit was activated under Title 10 orders during a 
qualifying time period. Am I eligible? 

Yes, you are a veteran. Title 10 orders are issued by 
the Secretary of Defense and therefore are federal 
orders. 

My National Guard unit was activated for crowd 
control under Title 32 orders during one of the 
qualifying periods. Am I eligible? 

No. Title 32 orders are issued under a governor’s 
authority, whereas Title 10 orders are issued from 
the Secretary of Defense. 

I’m currently a cadet at one of the U.S. Military 
Academies. Am I eligible? 

Yes, you are a veteran. The American Legion has 
considered service in the military academies as  
eligible for membership since WWI. 

Can I be an honorary or social member of The 
American Legion? 

No. Per National Constitution and By-laws, no form 
or class of membership is authorized except regular 
active or paid up for life. 

I served my entire military career in the National 
Guard/Reserves, and only have a DD214 from my 
Active Duty for Training that I was in during one 
of the qualifying dates. Am I eligible? 

Yes, you are a veteran. In the mid-60s all basic  
training and occupational training schools were  
considered federal active duty service. 

I served active duty as a SPAR, WAC, WASP, or 
WAVES during the one of the qualifying periods. 
Am I eligible? 

Yes, you are a veteran.  Even though women served 
separately than men, their service is equal. 

I served with allied military forces during one of 
the qualifying periods. Am I eligible? 

Yes, you are a veteran, only if you were a U.S. 
citizen at the time of entry. 

I served with the Civil Air Patrol/Civilian 
Technical Corps/USPHS as a civilian during two 
qualifying periods. Am I eligible? 

No. Eligible members must have federal military 
service during a qualifying period and received an 
honorable discharge or discharge under honorable 
conditions. 

I enlisted and went to basic training, but received 
an uncharacterized discharge due to a medical 
condition. Am I eligible? 

Yes, you are a veteran.  Uncharacterized discharges 
for medical discharges are assumed to be under  
honorable conditions unless specifically stated otherwise. 
There are other categories of uncharacterized  
discharges and before they are determined eligible 
for membership the discharge should be sent to  
National for determination and a record will be 
maintained at National on final determination. 

I’m eligible for The American Legion, but do not 
have a copy of my DD214 to show as proof of eli-
gibility. How can I get one? 

You can go to archives.gov/veterans to request 
another copy of your discharge papers. A copy of 
orders putting you on federal active duty can be used 
as proof of eligibility as well. 

— www.legion.org 

MILITARY TRIVIA:  

A. Germany has 8 US military 

bases with USAG Bavaria being the 
largest.   

mailto:membership@legion.org
http://www.archives.gov/veterans/military-service-records
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We are mailing ID Resolve on October 27th. 

 

QUICK REMINDER ABOUT 
ID RESOLVE: 

Protects your financial reputation with 24/7/365 
identity theft resolution services 

Eliminates the frustration and worries that come 
with being the victim of identity theft. ID Resolve 
helps get your money back, repair your credit, and 
clean up the mess left behind. 

Our U.S.-based team of resolution specialists knows 
who to call and which steps to take first when you 

fall victim to identity theft. 

Product may not be available in all states and may 
not mail all your members. If you want a more  
detailed description of this product, visit 

www.TheLIT.com/IDResolve. 

 

 

 

 

 

 

 

H ow are you doing? The opportunity to talk over 
personal challenges in a free, confidential, and 

non-judgmental setting is now available for anyone 
who served for any length of time. 
A veteran who is a trained Peer Support Specialist is 
now available for a Monday group from 4p-5p at the 
Lakes Region Recovery Center in Bridgton. 207-803
-8707. 

 

SHOP “AMAZONSMILE”  

& GIVE WHILE YOU SHOP! 

Support the American Legion Department of Maine 
Foundation when you shop on  
AmazonSmile. It’s the same as shopping on  
Amazon with the extra bonus that Amazon will do-
nate a portion of the price of eligible purchases.  

How to shop AmazonSmile:  

1. Go to http://smile.amazon.com and sign in with 
your Amazon.com credentials. If you already 
have an Amazon account, there is no need to cre-
ate another one.  

2. 2. In the search box, type American Legion  
Department of Maine Foundation and start shop-
ping. Amazon will donate 0.5% of the price of 
your eligible purchases to the American |Legion 
Department of Maine Foundation.  

3. Add a bookmark for smile.amazon.com. You 
must log in through the AmazonSmile portal 
each time you shop in order for our Foundation 
to receive the donation, so remember to add a 
bookmark to make it easier to return and start 
shopping on AmazonSmile.  

The funds go directly to the "American Legion  
Department of Maine Foundation to help Maine  
Veterans in need and support Legion programs  
in Maine!"  

Please help us get the word out to your friends and 
family! 

Shop “AmazonSmile” and make a difference To-
day! 
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